Golden (by Benthic Software)

Golden is a query tool for Oracle databases. It includes advanced query abilities, data editing,
and powerful import and export abilities including support for Excel and Calc spreadsheets.
Golden allows approved users access to submit SQL queries to the Administrative Information
System (AIS) and return useable data in a customizable format.

Access, Installation and Configuration
Before you begin using Golden there are three requirements:

1. Access to the RPT Database:
To request your RPT ID and password, CTRL+click on the following link:
https://eforms.siu.edu/siuforms/info/ais0101.php , or use your browser and navigate to
eforms.siu.edu. In the search box enter the form name “Request for Reporting Access
RPT”. Download and complete the form. In section 3 select ‘All Financials’ to gain access
to financial transactions. If you need special access to Human Resource or Accounts
Payable data, select the appropriate box. Because of the sensitive nature of the
information in these two modules, special access will be granted on a case-by-case
basis. Once you have completed the form and obtained the necessary signatures, mail it
to (Accounting Services MC: 6812). The form will be routed to the appropriate
approvers and you will be notified when your access is ready.

2. Installation and Configuration of the Oracle Client:
The Oracle Client is software that allows Golden to communicate with AIS. A copy of the

Oracle 11 Client can be downloaded here
(https://sql.siu.edu/downloads/Golden%20Setup.zip). Your LAN administrator should
use Appendix A below to install and configure the Oracle Client.

3. Purchase, Installation, and Configuration of the Golden Software:
The Golden software can be purchased and downloaded from
Benthicsoftware.com. Each department is responsible for the software purchase and
license storage. Be sure to download the latest 32-bit version. Your LAN administrator
should accept all default settings when installing Golden. Use Appendix B below to
complete the configuration.
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Using Golden

Now that you have Golden installed and configured to work with AlS, you can begin using the
software to pull data. Golden uses Oracle SQL queries, sometimes referred to as scripts, to
request data from AIS. This guide will help you access scripts, navigate Golden, run scripts and
export data to Microsoft Excel.

Script Access

To begin using scripts visit the SQL User’s Group website (https://sql.siu.edu/scripts.html). In
the blue box on the right side labeled ‘Base SQL Scripts’, are links to several basic scripts. Click
on each script’s link, download and save it to a location accessible from your computer. All SQL
scripts will end with the file extension ‘.sgl’ but most computers are not configured by default
to open this type of file. Consult with your LAN administrator to set Golden as the default
application for files ending with ‘“.sql’.

Navigation

Open Golden by selecting the Golden icon from the Benthic Software folder on your start
menu.

Enter your Username and Password in the appropriate boxes. Select ‘rpt’ from the dropdown
menu next to Database. Click the Login button.

S

Simple Login
|

Username: |siu850moc00c
) Close
Password: eeesssssssssense |

: Help
Database: rpt ~ |

Options...
[IRead Only

NOTE: The ‘RPT’ or “Report” database is a daily copy of the AlS database. The information
stored in RPT was posted to AlS the previous day. Each night the AlS database along with all
Usernames and Passwords is copied to RPT, and therefore require special attention when it is
time to change your password. Refer to the password change instructions below on Page 8.
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You are now logged into Golden and connected to the RPT database.
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At the top of the window you will see your username and the database you are connected to.
Below this is the Main Toolbar. This toolbar contains many of the standard toolbar options (i.e.
open, save & print) but also contains tools to run your script and export your data output. We
will look at these options later in this document.
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File Edit Script Results View Tools Help
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Below the toolbar is the query editing area. This area will display the script you intend to run
and allow you to edit the script to fit your needs. Most users will only display and run scripts
from this area. Editing scripts takes a basic knowledge of SQL.

Beneath the query editing area is the query output grid. This area is used to display the output
of your script.
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| File Edit Script Results View Tools Help
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[l transactions by bp and date.sql

ACCEPT beg_date PROMPT 'Enter the first DATE in your range (format: MM/DD/YYYY)'
ACCEPT end date PROMPT 'Enter the last DATE in your range (format: MM/DD/YYYY)'
|ACCEPT budget purpose PROMPT 'Enter the BUDGET PURPOSE (format: ######)"
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Running SQL Scripts

From the File menu select ‘Open’ then ‘Open file into new tab’. Alternatively, you can select
the ‘Open file into new tab’ icon from your toolbar.

-

| |
-

Navigate to one of the scripts you downloaded from the SQL User’s Group page and click the
Open button. For this demonstration we will use the script named ‘transbybpanddate.sql’.

File Edit Script Results View Jools Help
O-Z-HES:d-3- s 2EBD¢ % 7 2AL|4 4 14 B &
Ptransbybpanddate.sql

ACCEPT beg_date PROMPT 'Enter the first DATE in your range (format: MM/DD/YYYY)'
ACCEPT end_date PRCMPT 'Enter the last DATE in your range (format: MM/DD/YYYY)'
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select
gl.gl_code_combinations.segmentl as "Fund",
gl.gl_code_combinations.segment2 as "Unit",
gl.gl_code_combinations.segment3 as "Budget Purpose",
gl.gl_code_combinations.segmentd as "Dept Activity 17,
gl.gl_code_combinations.segmentS as "Dept Activity 27,
gl.gl_code_combinations.segment€é as "Function",
gl.gl_code_combinations.segment? as "Natural Account",
gl.gl_code_combinations.segmentE as "Object”,
gl.gl_code_combinations.segmentd as "Source of Funds",

_
» 1 No Records

The script will be displayed in the query editing area and can be modified. NOTE: If you are not
familiar with Oracle SQL you should not make modifications to the script. Even small changes
may prevent the script from running or provide incorrect output.

Notice there is nothing shown in the query output grid at this time. This area will remain blank
until you run the script. To run the script, select ‘Script’ then ‘Run script’ from your toolbar or
select the ‘Run script’ icon.
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NOTE: This script will prompt you for three variables (Start Date, End Date, and Budget Purpose)
however, many scripts are written with the variables defined and will not prompt you for input.

Enter each variable and click the ‘OK’ button. Once the last variable has been submitted, the
script will run. When the script is finished running, the query output grid will be populated with

the results.

Accept prompt variable value

‘Enter the first DATE in your range
(format: MM/DD YY)

Conce

Accept prompt variable value

‘Enter the last DATE in your range
(format: MM,DDY)

Cancel

Accept prompt variable value X

‘Enter the BUDGET PURPOSE (format:
FFEFER)

Cancel

The message ‘Done’ will be displayed in the lower left corner and the number of records
retrieved will be displayed in the lower right corner.

Fund . Unit sBudget Purpose 4 Dept Activity 1 » Dept Activity 2 s Function . Natural Account sObject s Source of Funds s Funding FY s Description

'12000003 20003 200003 00000
22000003 20003 200003 00000
3 2000003 20003 200003 00000
4 2000003 20003 200003 00000
52000003 20003 200003 00000
6 2000003 20003 200003 00000

<

€ Y Dong/ran 4 of 4 statements.

00000
00000
00000
00000
00000
00000

12 50000 4545 00
12 50000 445 00
12 50000 4545 00
12 50000 445 00
12 50000 4545 00
12 50000 4545 00
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Invoica Number: 2EE340761 | Supplier: Office Max
Invaioe Number: PCARD300000-1801 Supplier: Office M
Invaice Number: PCARDO10001-3001 Supplier: Office M
Invoice Number: 012120)d | Supplier: Office Max
Invoice Number: PCARD3000001-181| Supplier: Office M
Invoioe Number: 010020)d | Supplier: Office Max
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Exporting Data

Script results displayed in Golden can be useful for a small set of data however, to be useful
most output will require further calculations. To allow further manipulation of data,
applications like Microsoft Excel may be required. Fortunately, Golden has a built-in utility to
export data from the query output grid directly to MS Excel.

Once your script has finished running and you have results displayed in the query output grid,
select ‘Results’ then ‘Export results to Excel’.

Microsoft Excel will open and your output will be displayed in a new spreadsheet.

Bookl - Excel Cook, Loren A

Insert  Draw  Pagelayout  Formulas  Data  Review  View  Developer  Help  ACROBAT  Q Tell me what you want to do

Sy b cu abe | Calibi S e A S E=E % | B wepTet Text - B [ %ﬂ Ex E 3 Autosum - QY p

paste BICOW Strikethrough = <o o Conditional anf;ta; cﬁ\ Insert cfm Format A Sort & Find &

- ¥ Format Painter B L2 A= NepEmm = &0 WS Formatting = Table~ Stylesw - - - Clear~ Filter = Select -

Clipboard s More Font Font Il Alignment ] Number ] Styles Cells Editing ~

0O H B REQASSE @@ AP X -

AL - 5 Fund v
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1 [Fund__Junit  BudgetPurpose Dept Activity 1 Dept Activity 2 Function Natural Account Object Source of Funds Funding FY Description
2 (2030133 23002 200133 00000 00000 16 50000 4870 00 Yy Invoice Number: PA FY19#12-JUNE | Supplier: (Gjiiameigss- | Invoice Line Num: 1 | PO Num
3 2030133 23002 200133 00000 00000 16 50000 4870 00 Yy Invoice Number: PA FY19512-JUNE | Supplier: ESSSSEmmmepe. | Invoice Line Num: 1 | PO Nu
4 2030133 23002 200133 00000 00000 16 40000 1140 00 Yy V50 Pooled Int Dist. April-lune 2019 -
5 2030133 23002 200133 00000 00000 16 50000 4832 00 Yy Invoice Number: 2020245-QTR4-19 | Supplier: STILES OFFICE SOLUTIONS INCORPORATED | Invoic
6 2030133 23002 200133 00000 00000 16 50000 4101 00 Yy Pay Period Dates 23-JUN-2019 - 06-JUL-2019 -
7 2030133 23002 200133 00000 00000 16 50000 4201 00 Yy JV2019 ST14 Pay Period Dates 16-JUN-2019 - 29-JUN-2019 -
8 2030133 23002 200133 00000 00000 16 50000 4101 00 Yy JV2019 BW14 Pay Period Dates 03-JUN-2019 - 22-JUN-2019 -
9 2030133 23002 200133 00000 00000 16 50000 4725 00 Yy #72 STUDENT CENTER - IDENTIFICATION CARD ACTIVITIES -
10 2030133 23002 200133 00000 00000 16 50000 4201 00 Yy Pay Period Dates 30-JUN-2019 - 13-JUL-2019 -
112030133 23002 200133 00000 00000 16 50000 5381 00 Yy Invoice Number: 200105-22JUL18-001 | Supplier: C TELECOMMUNICATIONS-DEPARTMENTAL SER
122030133 23002 2001233 00000 00000 16 50000 4866 00 Yy Invoice Number: 10010-22JUL18-005 | Supplier: C SELF-INSURANCE PROGRAM-PROPERTY COVER
13 2030133 23002 2001233 00000 00000 16 50000 4882 00 Yy Invoice Number: 200028-23JUL18-066 | Supplier: C PHYSICAL PLANT SERVICE | Invoice Line Num:
14 2030133 23002 200133 00000 00000 16 50000 4808 00 Yy Invoice Number: 200031-23JUL18-008 | Supplier: C POSTAGE SERVICE | Invoice Line Num: 17 | PO
15 2030133 23002 200133 00000 00000 16 50000 4882 00 Yy Invoice Number: 200028-23JUL18-066 | Supplier: C PHYSICAL PLANT SERVICE | Invoice Line Num:
16 2030133 23002 200133 00000 00000 16 50000 5192 00 Yy Invoice Number: 200033-23JUL18-011 | Supplier: C TRAVEL SERVICE | Invoice Line Num: 23 | PO
17 2030133 23002 200133 00000 00000 16 50000 4101 00 Yy Pay Period Dates 07-JUL-2019 - 20-JUL-2019 -
18 2030133 23002 200133 00000 00000 15 50000 4101 00 Yy JV2019 BW15 Pay Period Dates 23-JUN-2019 - 06-JUL-2019 -

NOTE: If you have an Excel spreadsheet open and are in the process of editing a cell while
attempting to export data, Golden will display the following error message.

Error b4

Call was rejected by callee
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Password Change

Since RPT is a daily copy of AIS all usernames and passwords are also copied from AIS to RPT.
When you receive a message indicating your password has expired follow these steps to update
your password. NOTE: You will be updating your password in the AlS database, however this will
not change your access to AlS via the web portal. This username and password combination is
only used with Golden.

1. Open Golden and enter your Username and Password in the appropriate boxes.
2. Select ‘AlS’ from the Database dropdown menu and click the ‘Login’ button.
e You may be prompted to enter a new password at this time. If so, complete the

‘Set New Password’ box as indicated and click the ‘OK’ button. If not, go on to

step 3.

From the ‘File’ menu select ‘Change Password’.
4. Enter the updated password information and click the ‘OK’ button.

e You have now changed your password in the AIS database and it will be copied
to the RPT database when the daily copy is made. If you would like to run scripts
in RPT today, continue to step 5, otherwise you may close Golden.

e Note: The next time you open Golden the Database dropdown will be set to ‘ais’.
Before running scripts, you must change this to ‘rpt’ and enter your new
password.

5. Log out of AlS by selecting ‘File’ then ‘Disconnect’.

6. Loginto RPT by selecting ‘File’ then ‘Login’. Enter your Username and old Password in
the appropriate boxes.

7. Select ‘rpt’ from the Database dropdown menu and click the ‘Login’ button.

e You may be prompted to enter a new password at this time. If so, complete the
‘Set New Password’ box as indicated and click the ‘OK’ button. If not, go on to
step 8.

8. From the ‘File’ menu select ‘Change Password’.

9. Enter the updated password information and click the ‘OK’ button.

10. You have now changed the password in both AIS and RPT and will be able to run scripts
at this time.

w
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Appendix A:
Installation and Configuration of the Oracle Client
1. Copy ‘Oraclell’ folder directly under the C:\ directory.
2. Right-Click ‘This PC’ and select ‘Properties’.
3. Choose ‘Advanced system settings’ from the list on the left.

4. In the ‘System Properties’ window on the ‘Advanced’ tab select the ‘Environment
Variables’ button.

5. Under the ‘System variables’ section scroll down and select ‘Path’.
6. Click the ‘Edit’ button.

7. Click the ‘New’ button.
8. Type the path to the Oracle files c:\Oraclel1 then click the ‘OK’ button

Edit environment variable x

C\Program Files (x86)\Comman Files\OraclelJava'javapath New
%SystemRoot e\ system32 Edit
FSystemRoot3h
FeSystemRoot ¥\ System32\Whem Browse...
SYSTEMROOT %\ System32\WindowsPowerShell\w 1.0y
SYSTEMROOT ) System 32\ Open55HY Delete
C\Program Files\InteNWiFi\bin\

C\Program Files\Common Files\ntel\WirelessCommen,

Mave Up

Move Down

Edit text...

(9]



9. Under the ‘System variables’ section click the ‘New’ button to create a new system

variable

10. Enter ‘tns_admin’ in the ‘Variable name’ field and ‘c:\Oraclell’ in the ‘Variable value’

field

Edit System Variable *

Variable name: | tns_admin |
Variable value: c:\oraclel] |
Browse Directory... Browse File... Cancel

TR TTIOITATT T T I TSI T TW I TEFSTIrT

L e e e e e

11. Click ‘OK’ to save it and ‘OK’ until you are back to the ‘System’ window

12. Close the window and restart your computer
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Appendix B:

Installation and First Time Configuration of Golden

1. Purchase and Download the latest 32-bit version of Golden from benthicsoftware.com.

2. Double Click the Golden setup file.

3. Follow the prompts and choose the default settings

Once Golden is installed it will create the ‘Benthic Software’ folder in your program list. Inside

this folder you will find Golden.

Access
L. Adobe Acrobat DC
Adobe Acrobat Distiller DC

Alarms & Clock

. Benthic Software
&) Goldend
L Goldview32
I_E ImpExp6
C
E Calculator
Calendar
Camera

| febex Meetings Desktop...

e™ | Connert

£ Type here to search

Active Directory
Users and...

()

Configuration )
Manager... Paint 3D

&

Windows
Media Player
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Xbox Console...

4

Whiteboard

s

See all your mail in one place

© =

And more...


https://benthicsoftware.com/

Setting OCI.DLL Parameter in Golden

1. Open GOLDEN.
2. At the login window click the ‘Options’ button. (Note: If you do not see

the Options button click the ‘More’ button to display it.)

% Database Login - Golden6 %
Login: lcook@ais
Username: [icook |
Close
passnorc: [ETTIIIITITITIT |
Help
Database: |ais v|
Options...
[Jread only
Login List
Name  Usemame + Database  AltSchema  Category  Comment
lcook@ais lcook ais Auto
lcook@... lcook rpt Auto
New Edit Delete Fiter v | Import/Expart

3. In the ‘OCI DLL Name:’ box enter the following string: ‘C:\Oraclel1\instantclient_11_2\oci.dIl

| Lagin Options b

[ set focus to Username field on startup
Allow password saving
Auto add new logins to login list.
Database List
Add items from tnsnames.ora Edit Server List

Lowercase names from tnsnames.ora

Oradle Client Settings
Orade Client DLL: (Leave blank to autodetect)
|c:\0rade1wnsmntdient_u_z\pd.dll

Usge Unicode Crade Client calls
Use Unicode Data

4. Click ‘OK’
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Logon to Golden
1. Enter your ‘Username’, ‘Password’, and ’rpt’ in the ‘Database’ box.

(Note: The first time you open Golden the ‘Database’ box will be empty.)

Click ‘Login’

Simple Login
Username: |siuSSDXXXXX |
Close
Password: |uuuuuuuu |
Help
Database: |rpt v|
Options...
[1Read Only
Login List
Mame Username Database AltSchema Category Comment
siuB30... siu850098.. rpt Auto
New Edit Delete Filter = Import/Export ~

Setting the Oracle Date Format
1. While logged into Golden, select ‘Tools’.

2. From the Tools drop-down menu, select ‘Program Options’.

7% lcock@ais (lcook@ais) - Benthic Software: Goldend
Fde Edit Seript  Besuhts  View | Tools | Help

LA™ B - =7 Data import/Export...

‘Queryl Data Export of query at curment cursor position..
Golden
BLE#
GobdYiew

Iy Program Options...

¥ 1 No Records
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3. Enter the ‘Oracle Date Format’: MM/DD/YYYY HH24:MI:SS

Options

File Filters and Extensions Advanced Options
General | Editor | DataGrid | Menus | SyntexHighighting | SQULilder
Date &Time Formats (Leave blank to use defaults)
Oradle Date Format: ‘MM/DDM’W HH24:MI:55 @\

] Always show time [Ishow time first
[CIshow arid datetime in uppercase

Tabs & Windows

Page Tabs on Top [ side by side editor /datagrid (new tabs)
Putnew tab next to curent tab (] Show dbmsOutput on startup

[ Show Tabs Stacked swrupTabs: [ 1%

Show tab icons Tab Style: | Rounded sides -

Script & General

[ Autocommit Pause on PROMPT command
Scan for prompt vars (&, 8&)

[ Prompt vars match SQLPlus behavior

Default Script Directory: ‘ ‘

Default Spool Directory: ‘ ‘

Cancel Ok 8 Save as Defaults

4. Click the ‘Ok & Save as Defaults’ button.
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